
State to Receive Swine Flu Vaccine This Week 
 
By Emily B. Moses, Communications 
 
The first shipment of swine flu vaccine is on its way to Kentucky, Department for Public 
Health (DPH) officials announced last week. 
 
DPH placed its order for the first round of the vaccine last Wednesday, said DPH 
Commissioner Dr. William Hacker. 
 
The first allotment of vaccine contains 24,300 doses that will be distributed throughout 
the state to local health departments and numerous private providers. No county will 
receive fewer than 100 doses. This allocation of the swine flu vaccine is nasal spray 
vaccine only. 
 
“It’s important that we stress the first doses are of one formulation, the nasal spray,” said 
State Epidemiologist Dr. Kraig Humbaugh. “Certain priority groups should receive the 
swine flu vaccine, but not all of those can receive the nasal vaccine.” 
 
Unlike the flu shot, the nasal spray vaccine contains live flu material. For that reason, 
health officials do not recommend the nasal spray for all people. 
 
Health officials recommend these groups get the nasal spray vaccine: 
■ Healthy people 2 to 24 years old. 
■ Healthy people 2 to 49 years old who live with or care for children younger than 6 
months old. 
■ Healthy health care or emergency medical services workers who are 49 years old or 
younger. 
 
The groups of people who will be targeted for vaccination will expand to include others 
in coming weeks when the swine flu shot is available. 
 
“The bottom line is that we need most individuals to be patient and wait until more 
vaccine is available,” said Hacker. “Hopefully, around the first week of November, local 
health departments will be able to begin scheduling clinics to provide vaccine, and 
private health care providers will have more vaccine as well.” 
 
For more information about the swine flu vaccine, visit healthalerts.ky.gov.  
 
Changes in the 2007 Office system design 
 
Note: This is the second in a series introducing CHFS staff to changes and improvements 
in Microsoft Office 2007. The Cabinet will begin upgrading all staff to Office 2007 
beginning in November. 
 



Rather than 30 or so toolbars and commands buried on menus as in previous Microsoft 
Office versions, Office 2007 provides one control center, the Ribbon, that brings the 
essentials together and makes them more visible. 
 
The most often-used and preferred Office commands are now the most prominent.  
 
Some commands appear only in response to an action you take. For example, when you 
insert a picture in Word, the Picture Tools and commands appear on the Format tab.  
 
When you are through working with the picture and click away from it, the Picture Tools 
and the Format tab and its commands go away. If you need the tab again, simply click the 
picture. 
 
Put your own commands on the toolbar 
You can add your favorite commands to the Quick Access Toolbar located above the 
Ribbon. Just right-click any command or option button you want and then click Add to 
your Quick Access Toolbar.  
 
More options if you need them 
A small arrow  called the Dialog Box Launcher in the lower-right corner of a group 
means more detailed or advanced options are available for commands in the group. Click 
the arrow to open a dialog box or a task pane to work with the available options. 
 
What happened to the File menu?  
In several 2007 Office system programs, the File menu has been replaced with the 
Microsoft Office Button. Click this button in the upper-left corner of the window to get 
the same basic commands as in the previous File menu button, such as new, open, save 
and print. 
 
Program settings that control things like your preferences for correcting spelling are also 
accessible using the MS Office Button. Many of the options previously located in the 
Tools menu can now be found by clicking the Office Button. 
 
What about the new file formats?  
Office 2007 will open files created in Office 95 through 2003. When you save a file 
created in a previous version, the Save As default is to save the file as a previous version. 
You can also select to save the file as a 2007 version.  
 
When you save a file as a previous version, a Compatibility Checker will let you know of 
any 2007 features that may be disabled, or matched as closely as possible.  
 
Colleagues who have Excel versions 2000 through 2003 (and the latest patches and 
service packs) can work in your 2007 files. When they click on your document, they will 
be asked if they want to download a converter that will let them open your document.  
 
Watch a video demonstration of new Office 2007 features. 



 
Check out interactive training guides and menu and command mapping workbooks that 
show where commands and menus are located in Office 2007. 
 
Next week: What’s new with Outlook and Word 2007 

 
KCCVS Launches Statewide Food Drive 
 
By Anya Armes Weber 
 
The Kentucky Commission on Community Volunteerism and Service (KCCVS) is 
sponsoring a statewide food drive that is part of a massive national day of helping others. 
Governor Steve Beshear and First Lady Jane Beshear are encouraging all employees to 
contribute, and a special trophy is at stake for state agencies that participate. 
 
The Make A Difference Day food collection began Oct. 1 and ends Saturday, Oct. 24.  
 
“The name of this effort really says it all,” Gov. Beshear said. “The Make A Difference 
Day food drive will help so many Kentuckians through the hardest and coldest part of 
this winter. Participating groups are helping food banks and families right in their own 
communities.”  
 
KCCVS traditionally sponsors a food drive competition between AmeriCorps programs 
across the state and among regional offices of the CHFS Department for Community 
Based Services to feed hungry Kentuckians.  
 
This year, the food drive has been expanded to include other state agencies, and Governor 
and Mrs. Beshear have encouraged a good-natured rivalry among Cabinets. The Cabinet 
that collects the most food during the drive will receive a special KCCVS Governor’s 
award during the annual spring volunteerism recognition ceremony.  
 
“This is one competition where everyone will win,” the Governor said. “If every state 
employee in the Executive Branch brought one nonperishable food item, we would be 
able to reach thousands of families and help them fight hunger.”   
 
Food collected in each office will be delivered to local food banks.  
 
Last year, the state effort collected and distributed 71 tons of food to local food pantries 
and emergency feeding centers. That’s enough food to feed 283,880 Kentuckians.  
 
Created by USA Weekend magazine, Make A Difference Day is in its 19th year and is 
recognized as the nation’s largest day of doing good for others. Everyone is invited to 
participate under the ideal of “neighbors helping neighbors.” The annual event is 
observed the fourth Saturday of October – this year’s date is Oct. 24.  
 



For more information about Make A Difference Day in Kentucky, check out 
http://chfs.ky.gov/dfrcvs/kccvs/madd.htm. Log on to www.usaweekend.com/diffday to 
learn more about the national effort. 
 
For information about joining the state food drive through your office, call Janis Stewart 
at (800) 239-7404 or (502) 564-5343, ext. 4319. 
 
Commission Conducts Survey for Families of Children with Special Health Care 
Needs 
 
By Anya Armes Weber 
 
The Commission for Children with Special Health Care Needs (CCSHCN) is seeking 
input this fall through a survey that will help shape the way families with children who 
need special services receive assistance, and staff who works with these families can 
remind them of the survey. 
 
The survey is available online and can be completed electronically through Oct. 31.   
 
The survey link is on the CCSHCN Web site at http://chfs.ky.gov/ccshcn/default.htm. 
The survey is directed at youth diagnosed with a special health care need and families 
who care for children with special health care needs. 
 
CCSHCN serves youth ages 21 and younger who have special health care needs.  
 
Every five years, CCSHCN conducts a statewide needs assessment to determine what 
programs – including schools and school-based programs -- are helpful, what resources 
are available geographically and what resources families want but lack access.  
 
Staff is asked to share news about the survey with their families of children with special 
health care needs. 
 
Parents or caregivers of any child with special health care needs should complete the 
survey. Children do not have to be enrolled at the commission to participate in the 
survey. Any child who is old enough to answer the questions can also complete the 
survey.  
 
The survey is anonymous and can be completed in about 20 minutes from any computer 
with Internet access.  
 
Paper copies of the survey are available by contacting Stephanie Mitchell at 
stephanie.mitchell@ky.gov or (502) 429-4430, ext. 283. Mitchell can also give 
information about telephone surveys for individuals who cannot complete an online or 
paper copy.   
 
Living Well: Easy Tips for Eating Out 



 
By Kris Hayslett, Wellness Coordinator 
 
Have you stopped eating out in restaurants because you are trying to watch your weight? 
If so, consider calling in a reservation to your favorite restaurant and enjoying your next 
meal out. Follow these simple restaurant tips from MSN and Frank Bruni. 
 
Stop fasting beforehand: Avoiding food all day to prepare for a big meal will cause you 
to eat madly and mindlessly. This also defeats the whole experience of enjoying what you 
eat.  
 
Pace any alcohol: Space out your alcoholic drinks to limit your caloric intake and 
maintain good judgment on what you are eating.   
 
Remove the breadbasket: Enjoy the breadbasket. It’s a part of the meal, but have it 
removed after 10 minutes. Keeping it on the table will only promote mindless eating. 
Filling up on bread will increase your caloric intake and also leave you less room for the 
main course.  
 
Take inventory: Do an assessment of what you have eaten and what tastes good. If 
something does not taste the way you like, don’t eat any more. If you have tasted 
everything and you are not full, have a little more but don’t keep eating food that has a 
disappointing taste. 
 
Share a dessert: If you would rather eat dessert first, here is your chance to eat both a 
meal and dessert. Sharing is easier on both your wallet and your waistline. You will still 
enjoy a sweet fix, but without the additional guilt.  
 
Eating at home gives you total control over ingredients and portion sizes, but all of us 
enjoy dining out occasionally. Hopefully, these tips will help you survive your next 
restaurant outing. Other helpful tips are: 
 

 Order a salad as an appetizer with the dressing on the side. 

 Set your fork down after each bite to remind yourself to chew your food 
completely. This also allows the full feeling to transfer to the brain so you don’t 
overeat.  

 Share a meal or ask for a “to go” box and take home the other half for lunch the 
next day.  

 Eat a small snack between meals so you can pace yourself during a meal and 
enjoy the food.  

 
Navigating restaurant menus and weight loss is a tough challenge, but these simple tips 
will remove some of the guilt from eating out. The small changes we make in our eating 
behaviors are the first steps toward living a healthier lifestyle.  



 
Employee Enrichment 
 
By Anya Armes Weber 
 
Multitasking is a great way to be productive, but not if doing too many things at once 
causes the quality of your work to suffer. Business writer and human resources expert 
Martin Lindeskog offers these tips for streamlining your work productivity.  
 
Empty your e-mail regularly. Make it easier to find messages you need to keep by 
creating separate folders in your mailbox and filing messages as soon as you read them.  
 
Break down your assignments into smaller parts. At the start of every project, make a 
list of action items. You may be able to tackle some steps with work you’ve already 
completed. 
 
Keep a to-do list. Take this with you to all your meetings so you’ll be able to jot 
assignments or ideas you’ll need to remember. Cross things off as you complete them. 
Also, keep a paper or electronic calendar to stay on track for your meetings.  
 
Evaluate your work. There is always room for improvement. The last step of any project 
you do should be self-assessment. Take note of the things you want to do better for your 
next project.  
 
Kentucky Department for Public Health Launches New Public, Toll-Free H1N1 (Swine 
Flu) Hotline  
Hotline staff, Web site will help Kentuckians find information 
 
The Kentucky Department for Public Health (DPH) encourages Kentuckians to call a 
new toll-free hotline with their questions related to 2009 H1N1 influenza (swine flu) and 
seasonal flu for the latest news and information about flu. The toll-free hotline number is 
1(877)843-7727, and it will operate from 8 a.m.-10 p.m. daily. Information on the H1N1 
virus is also readily available by visiting the redesigned Health Alerts Web site at 
http://healthalerts.ky.gov.  
 
“We want Kentuckians to be able to access the most current and accurate information 
related to the ongoing 2009 H1N1 flu situation," said Gov. Steve Beshear. "Particularly 
now that vaccine is beginning to become available, we know that citizens will have 
questions about whether the H1N1 flu vaccine is right for them and when they might be 
able to receive it. The hotline and Health Alert Web site will provide easier access to the 
information they need." 
 
The flu hotline will be staffed by nurses and administered by Kosair Children’s Hospital, 
a part of Norton Healthcare, through a contract with DPH funded by a federal grant 
award related to H1N1 activities. Kosair Children’s Hospital also operates the state's 



Regional Poison Center hotline. The flu hotline will be active through at least the end of 
December. 
 
“As an advocate for children and families across the state, we are committed to ensuring 
that the public has access to the most accurate, up-to-date information about health 
issues, including H1N1influenza,” said Thomas D. Kmetz, president of Kosair Children’s 
Hospital and pediatric services at Norton Healthcare. “We are pleased to be able to 
partner with the state to help people get their questions and concerns about H1N1 
answered.” 
 
The Health Alerts Web site has also been relaunched in an easy-to-navigate format, and 
will be updated daily with new information about swine flu, seasonal flu and flu vaccines, 
as well as any other breaking health news. It includes resources for families and 
individuals, health care professionals, schools and day cares, other community 
organizations and business owners. It also provides information for the media. 
 
Kentucky was eligible to begin ordering 24,300 doses of nasal spray H1N1 vaccine last 
week, and expects shipments to begin arriving as early as today. The nasal spray vaccine 
can be taken by healthy individuals ages 2-49.  The first doses will be targeted mainly at 
health care workers under age 40 who are healthy, with broader availability as supplies 
increase. The H1N1 flu shot vaccine is expected to be available mid- to late October, 
with vaccine clinics for the public likely to be scheduled in early November.  
 
The symptoms of both seasonal and H1N1 influenza include fever, chills, headache, sore 
throat, cough, body aches, and may include vomiting or diarrhea. Individuals at higher 
risk for complications—such as those with chronic health conditions or who are 
pregnant—should contact a health care provider early, in case treatment with antiviral 
medication is necessary.  
 
Common sense precautions to prevent illness include: avoiding close contact with those 
who are ill; staying home when sick; covering the mouth and nose when coughing or 
sneezing; avoiding touching the eyes, nose or mouth; and frequent hand washing. 
 
For more information on seasonal and swine flu, visit http://healthalerts.ky.gov or follow 
KYHealthAlerts on Twitter.          
 


